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Not so long ago, it seemed the web browser
had replaced our email clients. Services such 
as Google’s Gmail became so convenient, 

powerful and easy to use, not to mention ubiquitously 
access from our phones, laptops and desktops, that 
running a standalone application seemed 
disconnected and old fashioned. But attitudes 
towards email have been changing, especially since 
Edward Snowden revealed that many online mail 
services did little to protect our privacy. 

This has given fully-fledged desktop applications a 
boost as we mix our accounts and services, or start to 
use encryption. And there’s a great selection of email 
clients for Linux. We love Gnome’s Geary, for example, 
and it’s done a wonderful job at re-inventing the simple 
and clean user interface for the web service 
generation. And Mozilla’s Thunderbird is still the go-to 
application for many, thanks to its rock-solid 
development, the sympathetic aims of the Mozilla 
Foundation and configurability.

But there’s another option that we don’t think is 
often considered, and that’s KDE’s KMail. KMail is a 
great choice because it can be made to look fantastic, 
it’s well integrated with any Linux desktop and utterly 
configurable. GnuPG encryption is almost transparent 
and there are powerful filters, anti-spamming and 
ad-blocking mechanisms. Its problem is that none of
this is apparent when you first install and launch the 
application. KMail can look old-fashioned and difficult 
to tame, and features such as custom tagging and 
virtual folders are barely documented. These are 
some of the problems we’re going to tackle over the 
next four pages, turning KMail into what we think is 
a contender for the best email client on Linux, and a 

great migration alternative to proprietary applications 
like OS X’s Mail or whatever Microsoft’s equivalent is 
these days.

Getting email
We’ve installed the latest version of KMail (version
4.14) into a KDE environment on both Arch and 
Kubuntu 14.10 for testing. In the years since its 
migration to the Kontact ‘PIM’ suite, the development 
pace has been slow and steady, which means there 
are still updates, but any version from the last year is 
basically functionally identical. We’re not huge fans of 
the ‘PIM’ suite concept, where email is integrated with 
contacts, notes, a journal and todo lists (we think PIM 
stands for Personal Information Management, was 
popular when email clients wanted to look like 
Microsoft’s Outlook). 

For that reason, we run KMail independently of the 
Kontact suite, despite Kontact being its default 
incarnation. In Kubuntu, for example, Kontact is 
launched from the Favourites list, whereas KMail can 
be found under the Internet category. Whichever you 
choose, the KMail component behaves identically.

When KMail is launched for the first time, you 
need to navigate past both the Tip of the Day, which 
can be bypassed, and the Account Assistant. This 
assistant is the best way of configuring KMail for 
your specific email account, and it will first attempt to 
guess settings the correct parameters using Mozilla’s 
connections database. If you’re using Gmail, for 
example, Mozilla’s database will provide the correct 
incoming and outgoing server details, and you’ll be 
able to choose between IMAP or POP3. If you’ve not 
configured email manually before, IMAP and POP3 
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WHY DO THIS?
•  Learn some of the most 

powerful sorting and 
aggregation functions of 
any email client that can 
help free your time.

 •  Impress your friends.

Without changing 
anything, KMail splits the 
main window into three – 
one panel for your folders, 
one for the message list 
and one that previews the 
email itself.

KMail is often overlooked because its default appearance 
filtering options don’t give the best first impression.
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are the two most popular protocols used to send
email from the server to your client. Most people use 
IMAP, because it allows you to leave the email on the 
server and only browse through subjects or download 
email on demand, if you need to. KMail supports IMAP 
push, which will inform you immediately as soon as 
you receive an email, rather than relying on polling the 
server every set period. It also allows you to check 
your email through other portals, such as through a 
web browser through Gmail or RoundCube. This isn’t 
normally possible with POP3 as emails are usually 
deleted after they’re sent to your client (this is an 
option for IMAP too). You may prefer to download and 
delete emails, as it reduces your online footprint and 
pulls all your email onto your hard drive, under your 
direct control.

We’re using online services like Gmail as a 
convenient example, but it’s important to remember 
that you can also pay for or install your own email 
domains and servers, so that you’re in control of every 
aspect of your email. This won’t necessarily make it 
any more secure – email is still sent from one server 
to another as plain text, with no guarantee of validity 
unless there’s a chain of encryption – but it removes 
your data from the meta-crawling context gathering 
of most online services. Even if you’re using an email 
client with a web service, this is still a step in the right 
direction. KMail is more extensible and more powerful 
than even the best web interface. With your own 
server, as long as you’re using the typical ports for 
IMAP or POP3, you’ll be able to enter your details just 
as you would with any other mail service.

After entering the details, you need to click on 
Create Account rather than Next, as this will just 
re-detect the server settings for you. Create Account 
will add your details to the KMail configuration, and 
you’ll be asked to create a KDE Wallet if you don’t have 
one already. This is a global password holder that 
stores important information, such as your email login 

details, behind a single password. After setup has 
completed, click on Finish. KMail will now go off and 
download your email and the time this takes is going 
to be entirely dependent on how much email is stored 
on your account and the speed of your connection. 
2GB of email took about 20 minutes to synchronise 
with KMail for us, with a decent internet connection.

The main window
With a fresh installation, KMail’s default window will list
your various email sources within a panel on the 
left-hand side and a simple ‘Changes’ page on the 
right listing whatever’s new in each version. But after 
your accounts have synchronised, you’ll find that the 
window on the right gets split into two. When you 
select an inbox or a folder from the panel on the left, 
the list of emails contained within that folder are listed 
in the top panel on the right, while the contents of any 
email you end up selecting will be shown in the 
bottom-right. You can change the size of any of these 
panels by click-dragging the divider. If you drag this 
divider to the border of the panel window, it will close 
one of the windows, and this can only be opened 
again by click and dragging the border down from 
where it’s now locked in place. This is difficult to spot 
if you don’t know there’s a ‘minimised’ panel there.

Folders in KMail are powerful. Right-click on one 
and select Folder Properties to see what we mean. 
You can have a different identity for each folder, for 
instance. Identities can be added and edited from 
the main Configuration panel (Settings > Configure 
KMail) and using a different identity for a folder might
be useful if it contains email forwarded on from a 
different account, or a different Linux alias. They’re 
also useful for mailing lists, where you may want to 
use a different identity or email address, and there 
are further options for mailing lists hidden within its 
own tab. You can customise how your reply will look 
and how the folder appears and is sorted, completely 
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What is Akonadi

It may have a silly name, but Akonadi is 
an essential part of how KDE applications 
work. As with lots of other parts of KDE, 
the motivation behind Akonadi is to avoid 
duplication and re-invention, and it deals 
specifically with the way your personal 
information is stored and accessed by 
other applications. It’s the framework 
that currently handles email, addresses, 
events, journals, calendars, notes and alarm 
settings. KMail uses Akonadi to manage 
your email while at the same time making 
it available to those applications and 
processes that you permit with their support 
for Akonadi. 

This could mean allowing the desktop to 
search and index your email, for instance, 
so that results are delivered from a global 
search prompt, but it could equally be about 
having a single contacts list of names and 
addresses, and sharing access to that list 

with all the applications that request it. This 
is how the same contact addresses work 
with both instant messaging and email, or 
how the content of your emails are delivered 
as search results through KRunner.

The most important thing to know about 
Akonadi is that while it is a database, it 
doesn’t actually store your email and you 
don’t have worry about adding anything 
too specific to your backup routine. If your 
emails are stored on an IMAP email server, 
they’ll still be stored there. If you’re using 
POP3, your emails will still be downloaded to 
your local maildir folder, just as they would 
with any other email application. Akonadi is 
an interface to these repositories and only 
stores metadata relating to those sources, 
not the actual data itself. It’s like Google for 
your personal information, with applications 
accessing this information through calls to 
the framework. 

In KDE 4, the resource configuration panel gives an 
overview of all the state of any Akonadi services you  
may be using.

PRO TIP
You can only run one 
instance of KMail but 
you can tab different 
views and open more 
than one window. Most 
configuration panels can 
also be opened at the 
same time.
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independently of any global settings or how
messages are listed in its parent folder.

One of the first improvements to the layout we’d 
recommend is dumping the default list of every email 
folder you’ve likely already created and switch to 
viewing only those you mark as favourites. This will 
help if you don’t want to see folders such as Drafts, or 
Spam, or Sent. There’s a separate panel (of course!) 
for favourites, and it’s above the mail folder view. 
You can drag it down if it’s hidden, and when empty, 
greyed-out text states “Drop your favourite folders 
here…” You can make any folder a favourite by right-
clicking on it and selecting “Add Folder To Favourites”. 
This may not make sense until you drag and hide 
the default list, leaving you only with those favourite 
folders you want to see. The Favourites view uses an 
icon view, but we find it more useful as as a list. Right-
click within the panel and select the Mode sub-menu. 
This gives you the option of switching to the list view.

We’re also not too keen on the way the message list 
appears above the message preview window. This is 
because we’d rather see a long list to provide context 

in the case of longer conversations, and the 6 or 7 
messages that fit into the default view aren’t enough. 
The ideal solution for us is to move the messages 
list view into its own panel, and the ability to do this 
is the last option hidden under the Layout tab in the 
main configuration panel. Select Show The Message 
Preview Pane Next To The Message List’ and the main 
user-interface switches from two columns to three, 
with the folder list/favourites on the left, the message 
list in the middle and the preview pane on the right. 
You can now drag the borders between these to 
adjust their horizontal size. In our opinion, this makes 
KMail far more usable.

Changing the message list
Two of KMail’s most powerful features are the
themeing and sorting engines which manage how the 
message list is displayed, and both of which can be 
different for different folders or views. This stuff is 
complex and little-understood, so we’re going to try 
and explain them both here and how you can create 
your perfect setup. If you get a lot of email, they both 
allow you to fine-tune the appearance of your inbox to 
give maximum context to your messages without you 
having to resort to clicking on them. 

How messages are listed is the result of three 
specific configuration options. The first is the 
aggregation mode. This governs how messages are 
threaded, or appear tabbed in from parent to child so 
that messages are grouped by conversation. The 
second is how those parent messages and their 
children are sorted, as once you’ve included older 
messages in a thread, you need more control over 
which messages appear where. Finally, there’s the 
theme options, which change how each header is 
displayed, along with the icons and actions that can 
be performed on a message. All three of these options 
are accessible from the View > Message List menu.

Before you can understand sorting, we need to 
understand what KMail calls message aggregation. 

It makes more sense to 
have a three-column view 
for emails, especially with 
the wider aspect ratio of 
most modern displays and 
laptops.

PRO TIP
KMail is a little over-
paranoid about HTML 
email, but it can render 
them without trouble if 
you enable the option 
in the security tab. 
We’d highly recommend 
sticking with plain text 
for your own emails, 
however.

Virtual folders

Yet another of KMail’s great but 
undocumented features is its ability to 
create virtual folders. These are equivalent 
to Gmail’s labels, and they enable you to 
sort email into dynamic groups without 
moving them from your inbox. You could use 
them to hold messages you’ve flagged as 
important, for example, or messages where 
you’ve added a descriptive tag, or even a 
folder to contain your previous searches. The 
secret to creating virtual folders is to use the 
search dialog, because it’s from there that 
you can save your search as a new folder. 
Open this dialog window by pressing S or 
clicking on Find Messages in the Edit menu. 
The window allows you to specify an inbox or 
folder and then to create a list of conditions 
that will need to be met for the search to 
return results. When you click on Search, 

the list view will be populated with results, 
You will now be able to enter a search folder 
name, which you can save by clicking on 
‘Open Search Folder’. This creates a virtual 
folder that will be listed alongside your other 
folders, and we’d recommend making this 
a favourite in the same way you would your 
other folders. It will automatically update 
with any new results for the search you 
entered, and can be removed with a right-
click and ‘Delete Search’.

Virtual folders automatically update when 
an incoming email matches a certain 
search criterion. But you can also use 
them to list flagged messages, such as 
those you’ve marked as important.
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Aggregation in this case means the way that related
messages are grouped together, mostly as a threaded 
conversation, but it also groups messages together 
according to the day. The ‘Activity by Date, Flat’ 
aggregation option, for instance, simply lists all the 
emails you’ve received today, with a marker dividing 
previous days. ‘Flat’ means there’s no threaded view 
of the conversation. ‘Activity by Date, Threaded’ is 
the same only with the emails branched off the first 
email in a thread when you click on the small cross 
to open the thread contents. A thread will include 
emails earlier than the date if KMail thinks they’re 
part of the same activity, with the latest email added 
to the bottom of the list. The next two options are 
very similar. ‘Current Activity’ is used to try to make 
an intelligent guess about the date of an email. Next 
there are aggregations that are easier to understand, 
including ‘Thread Starters’, a list of contacts and your 
conversations, a flat date view and a shallow list.

Most importantly, you can create your own 
aggregation theme by selecting the ‘Configure’ 
option at the bottom of the menu, which is exactly 
what we’ve done. We like to see threaded, open 
conversations arranged by the date, so we duplicated 
this configuration, opened the ‘Configure’ window and 
used the ‘Grouping and Threading’ tab to fine-tune 
the automatic expansion of threads, the smart date 
ranges and which messages are used at the head of a 
thread. You need to be slightly careful, because some 
of the aggregations will place new messages in past 
days as they attempt to keep new email together with 
an old thread. We also use ‘Perfect And By References’ 
as the threading policy, so that threads don’t become 
huge as KMail tries to keep every email you’ve ever 
sent. You can then save your own aggregation and 
use this on specific folders or globally.

And that leads us onto something closely linked 
to aggregation – sorting. Sorting options for the 
message list can be adjusted by selecting ‘Sorting’ 
from the View > Message List menu. Message 
sorting comes after aggregation, so you’ll still get the 

same view, but it allows you to switch between how 
activities and threads are displayed. Nearly all of this, 
such as ‘By Date/Time’, ‘By Sender’ or ‘By Receiver’ 
are self-explanatory, with perhaps the exception of 
‘By Date/Time of Most Recent in Subtree’. This is a 
reference to which message in a thread is used to 
group them together.

Finally, we get to change how the message list 
is rendered. This uses a small selection of themes 
that will change the font, position and information 
for exactly what information is included in each list 
item, as well as where each component is placed. You 
can customise the theme and download new ones, 
and we think it’s worth experimenting with because 
there are more options in the simple window that 
appears than you’ll find in the whole of a supposedly 
more complicated application such as Gimp. You 
can change everything, from the icons’ size and text 
colour, to how much the edges are rounded, and the 
way in which the background and foreground colours 
are rendered. Our layout has a ‘bold’ sender field in the 
most prominent position with the date and time to the 
right. Beneath this is the subject followed by the icon 
symbols. We feel this is the perfect balance. The only 
option we couldn’t find was a way to reduce the size 
of the indentation in threaded items. 

All this leaves us with a vastly improved email client 
and one that looks like it belongs in 2015 rather than 
2005. That KMail offers all these options is brilliant, 
even if that leaves us floundering for their meaning, 
and we like the contrast you find in KMail with an 
application like Geary, which we also like a lot but we 
just wish it had more options.  

Almost anything about the 
way the message list is 
presented can be changed 
with the theme editor.

Graham Morrison is a lapsed KDE developer and the editor  
of the magazine you’re reading. He gets a lot of mail. 

How messages are grouped and threaded can also be 
customised to fit the way you work.


